
Digital Forensics:
Advanced

Instructors:
Christopher (Cal) Lee
University of North Carolina at Chapel Hill

Kam Woods
University of North Carolina at Chapel Hill

December 13-14, 2021



About These Slides
Authors
Cal Lee, Kam Woods

Description
These are the slides from Cal Lee and Kam Woods’s “Advanced Digital Forensics” class. 
There are a number of hands-on exercises included. The sample data referenced in these 
slides is available here: https://github.com/BitCurator/bcc-dfa-sample-data/ 

Learning object type
Lesson plan/materials

Learning objectives
This learning object might be used in a lesson to satisfy the following learning objectives:
● Identify the appropriate tools to: safely acquire born-digital materials from storage 

media and other modes of transfer; assist in the appraisal of born-digital materials; scan 
for sensitive information in born-digital materials; and package born-digital materials for 
preservation and access.

● Practice using tools in the BitCurator Environment.

https://github.com/BitCurator/bcc-dfa-sample-data/


Curriculum and Certification Program 
offered by SAA:

▪ Foundational Courses—must pass 4

▪ Tactical and Strategic Courses—must pass 3

▪ Tools and Services Courses—must pass 1

▪ Transformational Courses—must pass 1

▪ Course examinations are 
administered online.

Digital Archives Specialist (DAS)



DAS Core Competencies Addressed
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• Understand the nature of records in electronic form, 
including the functions of various storage media, the 
nature of system dependence, and the effect on integrity 
of records over time.

• Formulate strategies and tactics for appraising, 
describing, managing, organizing, and preserving digital 
archives.

• Integrate technologies, tools, software, and media within 
existing functions for appraising, capturing, preserving, 
and providing access to digital collections.

• Curate, store, and retrieve original masters and access 
copies of digital archives.

https://www2.archivists.org/prof-education/das-curriculum-structure

https://www2.archivists.org/prof-education/das-curriculum-structure


Agenda
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Day 1

● Welcome and introductions

● Motivation and overview

● Technical fundamentals

● Data acquisition considerations

● Potential elements of your own 
digital forensics lab

● Bit-level treatment of individual files

● Creating and extracting forensic 
metadata

● BitCurator reporting features

● Other BitCurator environment tools

● Preview of Day 2

Day 2 

• Day 1 Postmortem – Questions, Concerns and 
Insights 

• Command-line operations in Linux 

• FIDO as an example of a command-line tool 

• Regular expressions 

• Extracting data from specific types of files: images, 
office files, email 

• Windows artifacts (including the Registry) 

• End user access (logistics and technical 
approaches) 

• Incorporating digital forensics into archival 
workflows 

• Challenges , Ethical/legal issues, and donor 
agreements 

• Wrap up and evaluations 



• Who’s teaching you?
• What about you?

• Who are you (name, institution, job title)?
• Why are you here (relevance to job, what 

you hope to get out of the workshop)?
• What have you done so far to apply digital 

forensics methods in your institution?
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Personal Introductions



• VirtualBox
• VirtualBox Extensions
• BitCurator Virtual Machine
• Exiftool (or on the web via https://exif.tools/)
• Sample data: 

https://distro.ibiblio.org/bitcurator/samples/saa-dfa-sample-data.zip
• Visit the link above and download this now if you have not already done 

so!
• Additional tools for Windows users:

• FTK Imager (Windows only)

• OSFMount (Windows only)

• RegRipper (Windows GUI, can also run at the command line in 
BitCurator environment)
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Software You Should Have Installed for the 
Exercises

https://exif.tools/
https://distro.ibiblio.org/bitcurator/samples/saa-dfa-sample-data.zip


• You’ve been charged with taking care 
of data from a prominent community 
leader who has died unexpectedly

• Her materials include some paper and 
lots of digital data (on floppies, CDs, and 
a laptop hard drive)

• What should you do with the floppies?
• CDs?
• Hard drive?
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Discussion Scenario



• Ensure integrity of materials
• Allow users to make sense of 

materials and understand their context
• Prevent inadvertent disclosure of 

sensitive  data
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Goals When Acquiring Born-Digital Materials



Provenance • Reflect “life history” of records
• Records from a common origin or source should  

be managed together as an aggregate unit
Original Order Organize and manage records in ways that reflect  

their arrangement within the creation/use  
environment

Chain of  
Custody

• “Succession of offices or persons who have held  
materials from the moment they were created”1

• Ideal recordkeeping system would provide “an
unblemished line of responsible custody”2

1. Pearce-Moses, Richard. A Glossary of Archival and Records Terminology. Chicago, IL: Society of 
American  Archivists, 2005.

2. Hilary Jenkinson, A Manual of Archive Administration: Including the Problems of War Archives and 
Archive  Making (Oxford: Clarendon Press, 1922), 11. 10

Fundamental Archival Principles to Apply



Provenance • Identify, extract and save essential information
about context of creation

Original Order • Reflect original folder structures, files associations,  
related applications and user accounts

Chain of  
Custody

• Documentation of how records were acquired and  
any transformations to them

• Use well-established hardware and software  
mechanisms to ensure that data haven’t been  
changed inadvertently

Identifying  
Sensitive  
Information

• Identify personally identifying information,  
regardless of where it appears

• Flag for removal, redaction, closure or restriction
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Digital Forensics Can Help Archivists to Fulfill 
Their Principles



• Archivists need to apply many more 
processes to born-digital records 
(e.g. integrity checks, metadata 
extraction, audit trails, characterization)

• The good news is that most of these 
processes can be performed by software

12

More Product, More (Machine) Processes



• In recent years, archivists have 
been applying various digital 
forensics methods, for example:
• use of write blockers
• generation of disk images
• applying cryptographic hashes to files
• capture of Digital Forensics XML (DFXML)
• scanning bitstreams for personally 

identifying

13

Digital Forensics in Archives



• Existing digital forensics tools provide  valuable 
functionality, but they don’t always fit well into 
primary workflows of archives.

• For example, archives are particularly 
concerned with:
• structure and persistence of metadata
• provisions for providing public access to data
• support for older technologies (e.g. 

floppy disks, HFS)

14

Need for Adaptation of Digital Forensics Tools 
and Tasks for Archivists
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https://bitcurator.net/wp-content/uploads/sites/1099/2018/08/bitstreams-to-heritage.pdf

https://bitcurator.net/wp-content/uploads/sites/1099/2018/08/bitstreams-to-heritage.pdf


• Install and operate the BitCurator environment as a virtual machine in VirtualBox
• Explain and recognize different types of metadata stored in common filesystems
• Identify file types based on magic numbers (file signatures)
• Determine potential hardware options for acquiring data from various types 

of storage media
• Apply common Linux commands at the command line and compose basic 

regular expressions
• Evaluate disk image format options based on needs and priorities of 

your institution and collections
• Generate BitCurator reports and use bulk_extractor to identify potentially sensitive 

data
• Extract and interpret EXIF metadata
• Capture and analyze Windows Registry artifacts using RegRipper
• Determine essential points in your institution’s workflows where it will be 

beneficial to incorporate forensics tools and methods
• Make and justify decisions of professional ethics that emerge when caring for 

born-digital records
• Recognize technical strategies for providing access 16

After this class, you should be able to:



• Advanced doesn’t mean "everything we didn’t 
cover in the Fundamental class"

• There’s much more about digital forensics that 
we won’t be addressing

• Selective hands-on experience with 
specific applications

• A license to learn more in the future

17

Caveats and Such



Level Label Explanation
8 Aggregation of objects Set of objects that form an aggregation that is meaningful

encountered as an entity
7 Object or package Object composed of multiple files, each of which could also

be encountered as individual files
6 In-application rendering As rendered and encountered within a specific application
5 File through filesystem Files encountered as discrete set of items with associate

paths and file names
4 File as “raw” bitstream Bitstream encountered as a continuous series of binary

values
3 Sub-file data structure Discrete “chunk” of data that is part of a larger file
2 Bitstream through I/O

equipment
Series of 1s and 0s as accessed from the storage media
using input/output hardware and software (e.g. controllers,  
drivers, ports, connectors)

1 Raw signal stream through
I/O equipment

Stream of magnetic flux transitions or other analog electronic
output read from the drive without yet interpreting the signal  
stream as a set of discrete values (i.e. not treated as a digital  
bitstream that can be directly read by the host computer)

0 Bitstream on physical
medium

Physical properties of the storage medium that are
interpreted as bitstreams at Level 1

Digital Resources - Levels of Representation*

*Covered in Fundamental class. See also: Lee, Christopher A. “Digital Curation as Communication Mediation.” In  
Handbook of Technical Communication, edited by Alexander Mehler, Laurent Romary, and Dafydd Gibbon, 507-530.  
Berlin: Mouton De Gruyter, 2012. 18

http://www.ils.unc.edu/callee/p507-lee.pdf
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3 Sub-file data structure Discrete “chunk” of data that is part of a larger file
2 Bitstream through I/O

equipment
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output read from the drive without yet interpreting the signal  
stream as a set of discrete values (i.e. not treated as a digital  
bitstream that can be directly read by the host computer)

0 Bitstream on physical
medium

Physical properties of the storage medium that are
interpreted as bitstreams at Level 1

Digital Resources - Levels of Representation*

*Covered in Fundamental class. See also: Lee, Christopher A. “Digital Curation as Communication Mediation.” In  
Handbook of Technical Communication, edited by Alexander Mehler, Laurent Romary, and Dafydd Gibbon, 507-530.  
Berlin: Mouton De Gruyter, 2012.

Levels where digital 
forensics methods and 
tools can provide a lot 
of assistance

19

http://www.ils.unc.edu/callee/p507-lee.pdf


• Funded by Andrew W. Mellon Foundation
• Phase 1: October 1, 2011 – September 30, 

2013
• Phase 2 – October 1, 2013 – September 30, 

2014
• Partners: School of Information and 

Library Science (SILS) at UNC and Maryland 
Institute for Technology in the Humanities 
(MITH)
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■ Develop a system for collecting professionals  
that incorporates the functionality of open 
source digital forensics tools

■ Address two fundamental needs not usually
addressed by the digital forensics industry:
◻ Incorporation into the workflow of archives/library  

ingest and collection management environments
◻ Provision of public access to the data

21

BitCurator Goals
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BitCurator Environment*
■ Bundles, integrates and extends functionality of open

source software
■ Can be run as:

◻ Self-contained environment (based on Ubuntu Linux) running 
directly on a computer (download installation ISO)

◻ Using “bootstrapping” installation scripts to turn any Ubuntu Linux 
machine into a BitCurator Environment

◻ Self-contained Linux environment in a virtual machine using e.g. 
VirtualBox or VMWare

◻ As individual components run directly in your own 
Linux environment or (whenever possible) Windows environment

*To read about and download the environment, see: 
https://bitcurator.net/

https://bitcurator.net/


Hands-On Familiarization  with VirtualBox 
and the  BitCurator VM*

*For a detailed walk-through of the steps we’re following, see the Quickstart
Guide:

https://github.com/BitCurator/bitcurator-distro/wiki/Releases#quickstart-guide
23

https://github.com/BitCurator/bitcurator-distro/wiki/Releases#quickstart-guide
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Get the software  
Documentation and technical  
specifications
Screencasts
Google Group
People
Project overview  
Publications  
News

https://bitcurator.net/

Twitter: @bitcurator 25

BitCurator Resources

https://bitcurator.net/
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Most tasks we will cover in this course are 
explained in the Quick Start Guide

https://github.com/BitCurator/bitcurator-distro/wiki/Releases#quickstart-guide

https://github.com/BitCurator/bitcurator-distro/wiki/Releases#quickstart-guide


https://bitcurator.net/wp-content/uploads/sites/1099/2018/08/code-to-community.pdf
27

https://bitcurator.net/wp-content/uploads/sites/1099/2018/08/code-to-community.pdf


• Continuing home for hosting, stewardship 
and support of BitCurator tools and 
associated user engagement

• Administrative home: Educopia Institute
• Funding based on membership dues
• Software and documentation are free and open 

source, but membership provides benefits (e.g. 
support, training, development  priority)

https://bitcuratorconsortium.org/
28

BitCurator Consortium

https://bitcuratorconsortium.org/
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Technical Fundamentals
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■ A given bitstream, fed into an algorithm, will generate a short string  
of characters that is extremely unlikely to be generated by a  
different bistream fed into that same algorithm

■ Most common = MD5, SHA-1
■ Can determine:

◻ If bits have changed after a transfer
◻ If bits have flipped within a storage environment
◻ Whether two different files are identical bitstreams

■ A library of hash values can identify “known and notable” (EnCase  
terminology) files
◻ Known – files that can be ignored (e.g. software listed in National

Software Reference Library)
◻ Notable – specific bitstreams that you’re trying to find

31

Checksums – Compact Representations of 
Bitstreams



In BitCurator environment: Right Click on File or Directory and Calculate MD5
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34



■ From a security perspective, MD5 has  been 
“broken” since 2005

■ SHA-1 was broken in February 2017

■ Someone with malicious intent can create 
two different bitstreams that result in the 
same hash (i.e. hash collisions)

35

Note on MD5/SHA1 - Potential Collisions



*Stefan Lucks and Magnus Daum, 
http://th.informatik.uni-mannheim.de/people/lucks/HashCollisions/
Wayback link: 
https://web.archive.org/web/20160713130211/http://th.informatik.uni-mannheim.de/people/lucks/Has
hCollisions/ 

36

Hash Collisions (The Poisoned Message 
Attack): "The Story of Alice and her Boss"*

http://th.informatik.uni-mannheim.de/people/lucks/HashCollisions/
https://web.archive.org/web/20160713130211/http:/th.informatik.uni-mannheim.de/people/lucks/HashCollisions/
https://web.archive.org/web/20160713130211/http:/th.informatik.uni-mannheim.de/people/lucks/HashCollisions/


Same MD5 Hash: a25f7f0b 29ee0b39 68c86073 8533a4b9 37



Alternatives to MD5?
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■ Originally developed by the NSA
■ Several variants: SHA-0, SHA-1, SHA-2 family
■ Early variants (SHA-0, SHA-1) known to be compromised
■ Most commonly used is now SHA-256. Can be used to  

process bitstreams (“messages”) up to 3.4 * 1038 bits  
(very large!)

■ Disadvantage: more time, computing power required to  
produce

Source: https://en.wikipedia.org/wiki/Cryptographic_hash_function 39

SHA (Secure Hash Algorithm)



■ Rarely a concern when hash is used for integrity checks 
on known items (e.g. verifying that a file was transferred 
correctly to a repository or that files in storage are still 
intact)

■ Can be a concern if one is relying on a hash as proof of 
record authenticity – risks can include cases of internal 
tampering

■ There are more robust hash algorithms to address this 
(SHA-2 family, including SHA-256) so good practice is to 
generate one of them along with the MD5

■ MD5 is still widely used, because it is fast to calculate and 
still widely supported

40

Implications of MD5/SHA1 Being "Broken"



Question:

Can you use a cryptographic hash to 
determine specifically what any given 
file contains?

If not, what could you use?

41



■ Access controls
■ File names & identifiers
■ File size (length)
■ Where to find files in storage (sectors and clusters)
■ MAC times

◻ Modified – when the content was last changed
◻ Accessed – time file was last accessed (by  

person or software)
◻ Changed – last time metadata changed
◻ Created – (implemented inconsistently, if at all,

across different file systems)
42

File System
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44

This is HFS+
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Name Operating System(s) Using it as Native File System [often other 
OSs can also recognize it]

FAT12, FAT16 MS-DOS

FAT32 (VFAT) Windows 95, 98

exFAT Windows XP SP2 and later (primary use: USB drives, SD cards)

NTFS Windows NT, 2000, XP, Server 2003, Server 2008, Vista

MFS Macintosh System 1-3

HFS (Hierarchical File System) Macintosh System 4-8

HFS+ Macintosh System 8.1 – 9, OS X 10.0 – 10.11

APFS macOS 10.12

ext, ext2, ext3, ext4 (Extended File 
System)

Linux

XFS Linux, typically Enterprise variants (RHEL)

HPFS (High Performance File System) OS/2

ISOFS (ISO 9660) Any OS that reads data from a CD

JFS1 (Journaled File System) AIX (IBM)

ReiserFS Several Linux distributions

UFS (Unix File System) aka FFS (Fast 
File System)

Various flavors of Unix
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Name Operating System(s) Using it as Native File System [often other 
OSs can also recognize it]

FAT12, FAT16 MS-DOS

FAT32 (VFAT) Windows 95, 98

exFAT Windows XP SP2 and later (primary use: USB drives, SD cards)

NTFS Windows NT, 2000, XP, Server 2003, Server 2008, Vista

MFS Macintosh System 1-3

HFS (Hierarchical File System) Macintosh System 4-8

HFS+ Macintosh System 8.1 – 9, OS X 10.0 – 10.11

APFS macOS 10.12

ext, ext2, ext3, ext4 (Extended File 
System)

Linux

XFS Linux, typically Enterprise variants (RHEL)

HPFS (High Performance File System) OS/2

ISOFS (ISO 9660) Any OS that reads data from a CD

JFS1 (Journaled File System) AIX (IBM)

ReiserFS Several Linux distributions

UFS (Unix File System) aka FFS (Fast 
File System)

Various flavors of Unix

Filesystems you’re 
most likely to 
encounter



■ Two disk images are in your zip file, and can also be found at:
https://digitalcorpora.s3.amazonaws.com/corpora/scenarios
/2009-m57-patents/usb/terry-work-usb-2009-12-11.E01  
https://digitalcorpora.s3.amazonaws.com/corpora/drives/np
s-2009-ntfs1/ntfs1-gen1.E01

■ Load each disk image into a separate instance of FTK 
Imager (run them side by side to  compare what you see) – if 
you don’t have a Windows computer, look on with a partner

■ Look at the properties of some files*
■ What differences do you notice?

*Properties are shown in the bottom left corner. If you don’t see them, go to the View  
menu at the top and select “Properties.” You may need to drag the top of the  
properties window up to see all of the values.
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NTFS vs. FAT File System Attributes

https://digitalcorpora.s3.amazonaws.com/corpora/scenarios/2009-m57-patents/usb/terry-work-usb-2009-12-11.E01
https://digitalcorpora.s3.amazonaws.com/corpora/scenarios/2009-m57-patents/usb/terry-work-usb-2009-12-11.E01
http://digitalcorpora.org/corp/nps/scenarios/2009-m57-patents/usb/terry-work-usb-2009-12-11.E01
https://digitalcorpora.s3.amazonaws.com/corpora/drives/nps-2009-ntfs1/ntfs1-gen1.E01
https://digitalcorpora.s3.amazonaws.com/corpora/drives/nps-2009-ntfs1/ntfs1-gen1.E01


Connecting a Device vs. Mounting a
Filesystem

48
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HFS+ volume is visible through Windows Disk Management after it’s connected
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But it's not visible through Windows Explorer, 
because Windows doesn't know how to mount 
the file system



■ Control Panel
■ Administrative Tools
■ Computer Management
■ Disk Management
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Seeing Attached Devices (Whether or Not 
They're Mounted) - In Windows
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Data Acquisition
Considerations
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■ Adoption comes and goes with changes in the industry
■ Those that have had wide industry adoption have usually  

lasted a decade or more
■ Important distinction: hardware protocol standards vs.

shape of connectors (related but not always the same)

Different USB connectors. From left to right: male Micro USB B-Type, UC-E6 proprietary (not USB), male Mini USB (5-pin) B-  
type, female A-type, male A-type, male B-type. Shown with a centimeter ruler. Female A-type connector (4th from left) is 
"upside  down" to show the pins.
https://en.wikipedia.org/wiki/File:Usb_connectors.JPG 56

Ports and Connectors

https://en.wikipedia.org/wiki/File:Usb_connectors.JPG


Micro SD to SD MicroSATA to SATA

SATA to IDE Ethernet to USB SATA to Molex Power

57

Adapter Examples

NVMe to USB



■ Some recent laptops, including all Apple laptops post-2019, the 
Microsoft Surface series of machines, and certain others, have 
both RAM and storage soldered to the motherboard; these drives 
cannot* be removed for imaging.
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A Note Regarding Modern Laptops (and other 
devices)

128GB Toshiba storage chip, 
Microsoft Surface Laptop 
motherboard (2019)

2 x 128GB Western Digital storage chips, 
Apple Macbook M1 Air laptop 
motherboard (2020)

*Except in specialized laboratories. 
See https://sumuri.com/how-to-image-an-apple-silicon-mac-with-recon-itr-live/ for an example of 
a commercial tool used to image Apple Silicon Macs without drive removal.

https://sumuri.com/how-to-image-an-apple-silicon-mac-with-recon-itr-live/


■ Current most common way 
to connect a mass storage 
device (e.g. solid state 
storage) to the inside of 
many desktop and laptop 
computers. Cable-less, 
connects via an edge slot.

■ Internal M.2 devices mount 
to the motherboard or a 
PCI expansion card. 
External M.2 devices 
typically housed in USB 
enclosures

512GB M.2 Mass Storage Device
https://en.wikipedia.org/wiki/M.2#/media/File:Intel_512G_
M2_Solid_State_Drive.jpg

M.2 connector on a motherboard
https://en.wikipedia.org/wiki/M.2#/media/File:M.2_conne
ctor_on_a_computer_motherboard.jpg
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M.2 (also known as "Next Generation Form 
Factor")



■ The most common way to 
connect a mass storage 
device (e.g.  hard drive, 
solid state  drive) to the 
inside of a  computer from 
2003 through the 
mid-2010’s.

■ eSATA used for  external 
mass storage  devices

Data Cables:
SATA on the left, eSATA on the right
https://en.wikipedia.org/wiki/File:SATA2_und_eSATA-Stecker.jpg

SATA Power Cable
60

Serial Advanced Technology Attachment 
(SATA)



■ Precursor to SATA
■ No longer widely used, but you’ll  

still find it on older drives
■ More than one drive can share  

the same cable, with one being  
the master (device 0) and the  
other being the slave (device 1) –  
these are set with jumpers

40-pin IDE Ribbon Cable
https://en.wikipedia.org/wiki/File:Nappe.sv
g

https://static.daniweb.com/images/attachments/0/maxtor_jumper.jp
g
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Integrated Drive Electronics (IDE) / AT Attach

http://static.daniweb.com/images/attachments/0/maxtor_jumper.jpg
http://static.daniweb.com/images/attachments/0/maxtor_jumper.jpg


■ Physical storage is similar to hard 
drives (magnetic charges in a spinning disk)

■ Various types and sizes, e.g. high 
density, double density, 3.5 inch, 5.25 inch, 
8 inch

■ 3.5 inch floppies are relatively easy to 
read using a USB drive, but older ones are 
more complicated…

62

Floppy Disks



Disc Ferret3

1. https://www.kryoflux.com/
2. http://cowlark.com/fluxengine/index.html
3. http://discferret.com/wiki/DiscFerret
4. http://www.deviceside.com/fc5025.html
5. http://disk2fdi.joguin.com/D2FCABLE.htm
6. http://www.cbmstuff.com/proddetail.php?prod=SCP

Kryoflux1

FC 50254 Disk2FDI5 SuperCard Pro6
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FluxEngine2

Floppy Controller Hardware

https://www.kryoflux.com/
http://cowlark.com/fluxengine/index.html
http://discferret.com/wiki/DiscFerret
http://www.deviceside.com/fc5025.html
http://disk2fdi.joguin.com/D2FCABLE.htm
http://www.cbmstuff.com/proddetail.php?prod=SCP


Many variations over time, often to increase storage density

Table source: https://en.wikipedia.org/wiki/List_of_floppy_disk_formats

*Coercivity is how resistant the medium is to being demagnetized (larger number
means it requires a larger magnetic field to be demagnetized) 64

Common Floppy Formats (Physical)

http://en.wikipedia.org/wiki/List_of_floppy_disk_formats


65

Actual bits on most IBM PC-type floppies are 
encoded using "modified frequency 
modulation" (MFM)

Table source: https://en.wikipedia.org/wiki/List_of_floppy_disk_formats 
 

https://en.wikipedia.org/wiki/List_of_floppy_disk_formats
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Actual bits on Apple (Macintosh and earlier) 
may be encoded using "group code 
recording" (GCR) or "modified frequency 
modulation" (MFM)

Table source: https://en.wikipedia.org/wiki/List_of_floppy_disk_formats 
 

https://en.wikipedia.org/wiki/List_of_floppy_disk_formats


■ Why is this important?
◻ Floppy disk drives write the actual bitstream using either  

GCR or MFM (or other, less common encodings)
◻ Drive won’t read disks encoded in a non-supported format

without specialized hardware (e.g. KryoFlux)
◻ Other factors:

■ Some devices (Apple in particular) use “CLV” (constant  
linear velocity), adjusting rotation speed depending on  
where the head is writing/reading

■ Others vary angular velocity of the disk based on zones
(“zoned CAV”).

■ Again, need specialized hardware such as Kryoflux to  
read these disks on a modern drive

67

Issues with Common Floppy Formats



■ Common IBM PC compatible  
floppies:
◻ Typically FAT12 with 512 byte  

clusters (although there are  
many less common variations)

Attribute FAT12

Used For Floppies and very small  
hard disk volumes

Size of Each FAT Entry 12 bits

Maximum Number of  
Clusters 4,086

Cluster Size Used 0.5 KB to 4 KB

Maximum Volume Size 16,736,256 bytes

■ Common Apple floppies (Macintosh and previous)
◻ Apple II: 13 sector disk (5.25”, ProDOS 3.2, 113.75K)
◻ Apple II: 16 sector disk (5.25”, ProDOS 3.3, 140K)
◻ Apple Macintosh:

■ Double-density 3.5” - Macintosh File System (MFS)
■ Double-density 3.5” - Hierarchical File System (HFS)
■ High-density 3.5” - Hierarchical File System (HFS)

68

Additional Factors: File Systems Used on 
Floppies
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Potential Problems with ISO 9660 Media (e.g. CD-ROMs)

Factor Complications

Physical damage May not be visible to the naked eye

Bad length in
volume header

Older CD writing tools sometimes miscalculated sector 
count, so header metadata doesn’t match  actual length

Incorrect block
size

CDs can misidentify as having 512-byte sectors

File truncation Filesystem may allow you to navigate to files 
that subsequently appear damaged or won’t render at  all 
(files could be truncated or never fully written to  disk)

One sector short 
when written Track at 
Once (TAO)

TAO disks often represent a length (in volume header) 
that is one sector short from the actual length

Not all tools are designed to recognize or address these issues



CD-ROM File System Structure

Note that there are structures, such as the Path Table, that are not generally used,  
but may contain metadata. For more info on issues in managing optical media, see:  
https://kamwoods.net/publications/woodsbrownarch09.pdf 70

https://kamwoods.net/publications/woodsbrownarch09.pdf
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Creating Disk Images of CDs

■ Cdrdao – primarily for ripping audio CDs 
(addressing issues such as the TAO one discussed 
above)

■ Often sufficient to use dd form CD-ROMs
◻ In the BitCurator VM, CD-ROM drive should 

appear as a device called /dev/sr0
◻ Command to acquire:

bcadmin@ubuntu:~$ dd if=/dev/sr0 of=FILENAME1.iso



■ To modify the file system, you can:
◻ Mount the disk image
◻ Use mkisofs to create a new ISO file system -

bcadmin@ubuntu:~$ mkisofs -r -o FILENAME2.iso /media/sr0

■ If you created an EWF image of a CD:
◻ BitCurator mounting scripts can’t determine whether the 

underlying disk image data is a raw (dd) image or an ISO
◻ To mount the image, first use ewfexport (command-line tool) 

to pull out the raw (dd) image, then rename it as an ISO

72

Dealing with Disk Images from CDs



■ Power - internal drive  
needs different connector  
(often Molex), not the kind  
that plugs into the wall

■ Cooling – when pulled  
from the computer, you’ve  
also separated the drive  
from the fan, so you  
should often add an  
external one to ensure  
cooling

https://en.wikipedia.org/wiki/File:Molex_female_connector.jpg

https://www.tigerdirect.com/applications/SearchTools/item
-details.asp?EdpNo=1648567
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Two Important Considerations for Internal 
Media that are Used as External Media

http://www.tigerdirect.com/applications/SearchTools/item-details.asp?EdpNo=1648567
http://www.tigerdirect.com/applications/SearchTools/item-details.asp?EdpNo=1648567


*Adapted from a Mini JukeBox setup designed by the National Library of 
Australia 74

Kryoflux installed and running in a mini jukebox



• Ensures that data can be read from the device, but
no bits can be changed

• Doesn’t just prevent changes conscious made by
user but also changes made by the system

• Options for write blocking (in order of most to least  
certain to prevent writes to the drive):
– Dedicated write blockers
– Writing blocking tabs or settings

on the device itself
– Software-based write blocking

Image source: http://thinng.com/1555-one-way-sign-seat 75

Write Blocking – One-Way Street for Data

http://thinng.com/1555-one-way-sign-seat
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Dedicated Hardware Write Blockers
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Hard Disk Write Blocker

A WiebeTech SATA/IDE write-blocker
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Hard Disk Write Blocker

This end connects to your computer using USB 2.0/3.0,  eSATA, 
or FireWire. The cables are in the box.
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Hard Disk Write Blocker

This end connects to the drive you want to image using SATA or IDE. 
There are power cables in the box that can connect to  either drive.
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Hard Disk Write Blocker

This end powers the write blocker itself. There’s a power supply in 
the box.
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Hard Disk Write Blocker

The WiebeTech Combodock V5 supports both USB 2.0 and  USB 3.0. 
USB 3 is faster, but may not always be compatible with all computers.
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Hard Disk Write Blocker

The ComboDock has been connected to an IDE drive, a host computer, 
and powered on. It will allow you to select write-blocked or read/write. 
“Enter” enables write-blocking.
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Hard Disk Write Blocker

The drive is now fully powered, and you can use the dock to examine 
some metadata…
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Hard Disk Write Blocker

This drive has just been powered on, and it’s registering as 14 degrees 
Celsius (57 Fahrenheit). This is well below room temperature, but it will 
quickly rise without a fan.
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Hard Disk Write Blocker

This drive is indicating a raw capacity of 156 thousand 
megabytes (about 150GB).
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Hard Disk Write Blocker

The name of the manufacturer is embedded in the metadata.
Why might this be important?
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Hard Disk Write Blocker

The model number is next. This number is *not* unique, but common to 
many drives.
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Hard Disk Write Blocker

The serial number, however, *is* unique.



A USB Write Blocker

89
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USB Write Blocker

Above is a USB write blocker manufactured by Tableau.
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USB Write Blocker

This end has a power connector for the blocker, and a USB  ‘b’ port to 
connect to the host. The FireWire port is just for updating the write 
blocker firmware. It has no other use.
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USB Write Blocker

This end connects to the USB device. This particular write-blocker will 
*not* recognize USB floppy drives, only USB flash drives and USB hard 
disks. And look, a power switch.
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USB Write Blocker

Here’s what it looks like when everything is plugged in. Plug
everything in before turning the write-blocker on.
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USB Write Blocker

Once you turn it on, the “Host Detect” and other lights will light  up. If “Host 
Detect” doesn’t light up, the write blocker can’t see  your computer. 
Something has gone wrong.
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USB Write Blocker

Different write blockers may expose different metadata. This write 
blocker displays the product name, in addition to the  manufacturer.



Host-Based Write Blockers

96



▪ The “UltraBay” on the FRED  
provides write blocking for a  
range of interfaces.
▪ USB (top left, next to power  

switch)
▪ SCSI (right of USB) [no longer

included in newer FREDs]
▪ PATA/IDE (below SCSI)
▪ SATA (left of IDE)

▪ It also includes a MOLEX power 
connector.  There’s a cable in the 
toolbox that converts this to 
SATA  power, if required.

▪ The ports in the white box on  the 
right (top picture) are NOT  
write-blocked.

In earlier FREDs:

On newer FREDs:

97

FRED UltraBay



https://en.wikipedia.org/wiki/File:Floppy_tabs_3x2.jpg
98

5.25 Inch Floppy – If light can get through, it's 
not write protected



Source: http://www.techmint.info/2009/09/security-write-protecting-floppy-disks.html
Current: 
https://web.archive.org/web/20100125050630/http://www.techmint.info/2009/09/security-write-protecting-flop
py-disks.html 99

3.5 Inch Floppy – If light can get through, it 
is write protected

http://www.techmint.info/2009/09/security-write-protecting-floppy-disks.html
https://web.archive.org/web/20100125050630/http:/www.techmint.info/2009/09/security-write-protecting-floppy-disks.html
https://web.archive.org/web/20100125050630/http:/www.techmint.info/2009/09/security-write-protecting-floppy-disks.html


Example of Software Write Blocking – Mounted Devices set to Read-Only by Default

100



■ Macintosh: Disk Arbitrator “will block the mounting of 
file systems to avoid mounting as read-write and 
violating the integrity of  the evidence”
https://github.com/aburgh/Disk-Arbitrator

■ Windows: See “Digital Forensics: How to configure 
Windows Investigative Workstations”
https://www.sans.org/blog/digital-forensics-how-to-
configure-windows-investigative-workstations/ 
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Other Potential System Changes to Reduce 
Risk of Writing to File Systems

https://github.com/aburgh/Disk-Arbitrator
https://www.sans.org/blog/digital-forensics-how-to-configure-windows-investigative-workstations/
https://www.sans.org/blog/digital-forensics-how-to-configure-windows-investigative-workstations/


Potential Elements of your own
Digital Forensics Lab

102
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FRED Options from Digital Intelligence

https://digitalintelligence.com/products/overview
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Mini Jukebox

“Prometheus Component Installation Guide Pre-install requirements and 
methodology.” National Library of Australia. October 22, 2008.



Stanford University Libraries and Academic Information
Resources (SULAIR)

105
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The British Library (UK)
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School of Information and Library Science at 
UNC Chapel Hill, North Carolina



https://bitcurator.net/2013/08/02/building-a-digital-curation-workstation-with-bitcurator
-update/ 108

https://bitcurator.net/2013/08/02/building-a-digital-curation-workstation-with-bitcurator-update/
https://bitcurator.net/2013/08/02/building-a-digital-curation-workstation-with-bitcurator-update/
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Outfitting a Born-Digital Archives Program 
(Ben Goldman, Penn State University)

https://practicaltechnologyforarchives.org/issue2_goldman/ 

https://practicaltechnologyforarchives.org/issue2_goldman/


https://mediapedia.nla.gov.au/ 
110

Useful Resource - Mediapedia

https://mediapedia.nla.gov.au/


■ Getting an “image” of a storage 
medium involves working at a level below 
the file system

■ Can get at file attributes and deleted files 
not visible through higher-level copy 
operations
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Creating Exact Copies of Data from Media – 
Disk Images
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Creating a Disk Image in Guymager



■ RAW and Split RAW (RAW stored across multiple files)

■ Advanced Forensics Format (AFF) [no longer 
recommended]

■ EnCase Evidence File (.E01)

■ ISO (for CD-ROM)

■ IMG (floppy or sometimes CD-ROM)

113

Examples of Disk Image Formats



■ Copies of the raw media data. Often split into smaller chunks to make them more  
manageable and so that the resulting images can fit onto limited filesystems and  
media such as FAT or DVD/CDROM.

■ Advantages:
■ Very simple, use simple tools to manipulate the image.
■ Image can be easily split for storage and transport on removable media
■ Output can be piped to other applications for immediate processing

■ Disadvantages:
■ Can be very large (no compression). Zipped raw images cannot be  

operated on directly with regular tools (efficiently perform arbitrary seeks).
■ Often too large to store on FAT formatted media
■ No metadata other than filenames, no hashes.
■ No checksumming on files – not robust

◻ Missing segments (for example from scratched CD/DVD – can  
sometimes be overwritten with 0’s).

◻ Overwritten data (unrecoverable – no checksums on small blocks in  
file).

114

RAW (dd)



■ Evidence file consists (in order) of: Acquisition information, Data Block,
CRC (cyclic redundancy check), acquisition hash (MD5)

■ Can be split for storage, transport
■ CRC computed for every 32K block; balance between integrity and  

speed, also makes it very difficult to tamper with the evidence file (1 in  
4 billion chance of collision)

■ Cannot be manipulated with simple (open source UNIX) tools; support  
reverse engineered in libewf

■ Previously limited to 2GB size
■ Largely proprietary
■ Has been reverse engineered by Joachim Metz in libewf (used in open  

source tools that read EWF) - https://github.com/libyal/libewf 
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Expert Witness Format (Encase)

https://github.com/libyal/libewf


■ Similar to raw, but can’t contain
◻ multiple tracks
◻ audio or video tracks

■ Don’t contain control headers or error 
correction fields (raw can include these)

■ Filesystem usually will be either ISO 9660
(CD-ROM) or UDF (DVDs)

116

ISO Images (.iso extension) for CD-ROM and 
DVD



■ Virtualization and emulation
■ Mounting the original filesystem
■ Accessing (but not mounting) disk images  

using forensics software
■ Two options discussed later for end user

access:
◻ Remote, dynamic access to disk image

contents
◻ Cross-drive analysis

117

Accessing Data in Disk Images



https://eaasi.gitlab.io/program_docs/intro-emulation-workshop/06-eaasi/index.html 118

Emulation as a Service

https://eaasi.gitlab.io/program_docs/intro-emulation-workshop/06-eaasi/index.html


119

What's the difference between the two options 
shown in FTK Imager below?
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Mounting a Disk Image to Browse the Contents
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Mounting a Disk Image to Browse the Contents
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Exporting Selected Files from a Disk Image
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Exercise: Multiple Views into Disk Image Files
■ Resources we’ll be using (also in the zip file you downloaded):

1. ISO file - http://www.ils.unc.edu/callee/25.iso 
2. IMG file – https://distro.ibiblio.org/bitcurator/lab/something.img 
3. OSFMount (Windows only)
4. FTK Imager (Windows only)
5. BitCurator Environment

■ Step 1 – Mount the ISO and IMG files using OSFMount
■ Step 2 – Find the drives using Windows Explorer and investigate

their contents
■ Step 3 – Open FTK Imager and add both images as evidence 

items, and explore what we see in the drives
■ Step 4 – Use the BitCurator environment to mount the disk images

[Right click on image file, then select: Scripts > Mount Disk Image]
■ Step 5 – Use the BitCurator environment to select files within 

the images to export [Use Forensics Tools > BitCurator Disk 
Image Access]

http://www.ils.unc.edu/callee/25.iso
https://distro.ibiblio.org/bitcurator/lab/something.img


Bit-Level Treatment of Individual Files

124



■ A more compact and more humanly readable 
way of conveying a stream of bits

■ Uses hexadecimal notation
◻ Each character represents one of 16 possible values

(0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F)
◻ Conveniently, a series of two characters represented  

in hexadecimal can represent exactly one byte (28 =  
256 possible values) of data, because 162 = 256

■ Hex dumps from computer’s memory often used 
for debugging or reverse engineering 
software and for data recovery

125

Hex Dump



■ Many free or inexpensive tools available  for 
download, e.g. Cygnus Hex Editor, Hex 
Workshop, HexAssistant, MiniDumper, Hex 
Fiend (Mac), GHex (Linux)*

■ BitCurator environment has a built-in hex
editor (GHex)

Online tool: https://hexed.it/ 

* See https://en.wikipedia.org/wiki/Comparison_of_hex_editors 126

Hex Dump Tools

https://hexed.it/
http://en.wikipedia.org/wiki/Comparison_of_hex_editors


In the BitCurator environment:

127



128



■ Magic numbers and file signatures

■ File extensions

■ Metadata stored in file system

■ MIME types

129

Identifying File Types



■ Distinct string or pattern that is found within files of a
given type (most often in the header)

■ Most effective searches for magic numbers often involve 
regular expressions (e.g. grep) in order to 
indicate multiple variations of a pattern

■ Utilities that use this: file (Unix), TrID, DROID, FITS
■ Examples:

File Format Hex ASCII

DOC D0 CF 11 E0 A1 B1 1A E1 ÐÏà¡±á

JPG FF D8 FF ÿØÿ

PDF 25 50 44 46 2D 31 2E %PDF-1.

ZIP 50 4B 03 04 PK..

130

Magic Numbers and File Signatures



■ FITS “identifies, validates, and extracts technical metadata for  
various file formats. It wraps several third-party open source tools,  
normalizes and consolidates their output, and reports any errors.  
FITS was created by the Harvard University Library Office for  
Information Systems for use in its Digital Repository Service (DRS).”

■ Tools currently bundled into it:
◻ Jhove
◻ Exiftool
◻ National Library of New Zealand Metadata Extractor
◻ DROID
◻ FFIdent
◻ File Utility (windows)

■ FITS may no longer be available as a part of BitCurator due to JRE
incompatibilities

131

File Information Tool Set (FITS) 
https://code.google.com/p/fits



http://www.itforarchivists.com/siegfried/
■ Signature-based file format identification tool

◻ PRONOM file format signatures (National  
Archives of UK) (default)

◻ MIME-info file format signatures
(freedesktop.org)

◻ FDD file format signatures (Library of  
Congress)

■ Unlike FITS, does not have validation built in,  
and fewer extraction tools, but much lighter  
weight.

■ Has a lot of customization for output
◻ CSV
◻ YAML (text)
◻ DROID CSV
◻ JSON
◻ stdout
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Siegfried

http://www.itforarchivists.com/siegfried/


■ Reporting companion for Siegfried
◻ Requires Siegfried (but running Brunnhilde also runs Siegfried)
◻ Command-line and GUI (we’ll be using the CLI version later)

■ Reports generated
◻ HTML (human readable)
◻ Siegfried CSV
◻ Directory tree
◻ Other CSVs extracted from Siegfried logs (e.g., warnings,  

unidentified files)
■ Can run other processes too, but not required

◻ Virus scan
◻ bulk_extractor
◻ Disk image processing

https://github.com/tw4l/brunnhilde
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Brunnhilde

https://github.com/tw4l/brunnhilde


■ Changing file extension usually changes 
default application OS uses to open (i.e. associates with) 
the file

■ The "8.3" (eight characters, followed by 
three-character extension) limit in the past – based on 
FAT – resulted in many creative uses of the extension 
part of the file name (e.g. reports1.994, april-94.rpt)

■ Convention is often still to use only three letters
■ No authority for standardizing use, so three-letter  

extensions are often shared by many formats
■ Security risks associated with trusting the file extension 

to  be accurate – malicious code masquerading as 
another type of file (e.g. viruses sent as email 
attachments)
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File Extensions
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■ Widely adopted and recognized by 
applications

■ Based on two-level hierarchy (e.g. 
text/html, application/octet-stream, 
image/tiff)

■ Major advantage is official registration of 
MIME types through a central authority

136

MIME types ("Content-type", "internet media 
type")



MIME types

https://www.iana.org/assignments/media-types/media-types.xhtml 137

https://www.iana.org/assignments/media-types/media-types.xhtml


■ The NSRL (https://www.nsrl.nist.gov) includes a library of hashes 
of files associated with a large number of software tools developed 
over the past few decades. See the product list at:

https://www.nsrl.nist.gov/RDS/rds_2.41/ProdList.txt

■ Various third-party tools can be used to  access the NSRL. There’s 
a web interface available at:

https://www.hashsets.com/home/

(Navigate to Hash Set  Engines > National Software Reference 
Library >  SEARCH BY NAME / MD5). But it often generates  
invalid results, so the following instructions are based on  running a 
command-line tool instead.

138

National Software Reference Library (NSRL)

https://www.nsrl.nist.gov/
https://www.nsrl.nist.gov/RDS/rds_2.41/ProdList.txt
https://www.hashsets.com/home/


■ Find a directory from your computer that contains system files.
◻ For Windows, a good place to look is in Computer > Local Disk (C:) >

Program Files. For example, you could select Program Files > 7-Zip.
◻ On a Mac, look in /Applications/ and select a specific folder

■ Move the contents of the directory to a new folder called system-files on your  host 
computer’s desktop.

■ Navigate to your shared folders [Desktop > Shared Folders and Media] in the  BitCurator 
environment and copy the folder system-files to the desktop of the  BitCurator 
environment

■ Use md5deep to create a set of md5 hashes of the files in the system-files  folder, then 
pipe the output into nsrllookup to generate lists of known and  unknown hashes:
◻ md5deep –r ~/Desktop/system-files | nsrllookup –s nsrllookup.com -K  

known-hashes.txt -U unknown-hashes.txt
■ What is the above command doing?
■ Look at the contents of the two files:

◻ type known-hashes.txt
◻ type unknown-hashes.txt

139

Using NSRL Hash Sets to Investigate System 
Files



■ Visit: https://rjhansen.github.io/nsrllookup/ and download 
the Windows binary (64-bit).

■ Open the .zip file and extract the executable to your desktop.
■ Visit: https://github.com/jessek/hashdeep/releases and 

download md5deep-4.4.zip.
■ Open the .zip file and extract md5deep64.exe to your

desktop.
■ Open a command prompt window (in the start box, 

type “cmd”). Navigate to your desktop (cd Desktop).
■ Type: nsrllookup –help
■ Same commands as in previous slide but use quotation 

marks around the file path in the command.
140

For Your Reference: Running NSRL Lookup in 
Windows

https://rjhansen.github.io/nsrllookup/
https://github.com/jessek/hashdeep/releases
https://github.com/jessek/hashdeep/releases/download/v4.4/md5deep-4.4.zip


The PRONOM technical registry contains information about a 
wide variety of file formats, including versioning information. You can 
find it  at https://www.nationalarchives.gov.uk/PRONOM/Default.aspx.
PRONOM has an online search feature that can be used to view 
the  registry.

Click on “Search PRONOM” and navigate to the “File Format” tab.  
Clicking on the first search button (under “1. File Formats”) will allow  
you to view all of the entries in the registry.

DROID incorporates information from PRONOM. It also uses file 
magic  and file format extensions to provide a “best effort” at identifying 
file  types. If you’d like to know more about DROID, you can find a 
quick  demonstration video at: https://vimeo.com/24718678

Note: We’ll see DROID output in the Siegfried exercise later. 141

Exercise: Using PRONOM

https://www.nationalarchives.gov.uk/PRONOM/Default.aspx
https://vimeo.com/24718678
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Creating and Extracting Forensic Metadata
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High-Level View of Metadata Generation and Reporting

See: Woods, Kam, Christopher Lee, and Sunitha Misra. “Automated Analysis and Visualization of Disk Images  and File 
Systems for Preservation.” In Proceedings of Archiving 2013 (Springfield, VA: Society for Imaging  Science and Technology, 
2013), 239-244.



https://github.com/dfxml-working-group/dfxml_schema 144

https://github.com/dfxml-working-group/dfxml_schema


Operationalizing Original Order - Filesystem Metadata Output from fiwalk*

*Developed by Simson Garfinkel 145



PREMIS (Preservation) Metadata Generated from Running
BitCurator Tools – Recorded as PREMIS Events
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Provenance – DFXML Output from fiwalk
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Identifying “Features” of Interest in Disk 
Images or Directories

Bulk Extractor

148
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Bulk Extractor* – Identifying Potentially Sensitive Information

See: https://forensicswiki.xyz/wiki/index.php?title=Bulk_extractor

*Developed by Simson Garfinkel 150

https://forensicswiki.xyz/wiki/index.php?title=Bulk_extractor
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Histogram of Email Addresses (Specific Instances in Context on Right)
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BitCurator Reporting Tool
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Various Specialized BitCurator Reports
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Detail: Specialized BitCurator Reports
File Content
bc_format_bargraph.pdf histogram of file formats found on

the volume
bulk_extractor_report.pdf high-level overview of feature  

locations on disk
fiwalk_deleted_files.pdf shows paths to any deleted  

materials found in a given partition

fiwalk-output.xml.xlsx Excel converted DFXML output (file  
system metadata)

fiwalk_report.pdf high-level overview of file system
characteristics

format_table.pdf long-form file format names for  
formats shown in bar graph

premis.xml PREMIS preservation metadata



■ Scripts that can be run using Nautilus (GNOME  
file manager)

■ Most provide more convenient access (right 
click and menu selection) to functions performed 
by applications that could also be run directly
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Nautilus Scripts
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Right-click on file or directory and create MD5
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Quick access to a hex view
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Other functionality to meet user needs
Function Tool(s)
Identify duplicate files FSLint
Characterize files FITS, FIDO
Scan for viruses ClamTK
Examine, copy and extract information from old Mac disks HFS Utilities (including HFS 

Explorer)
Capture AV file metadata MediaInfo, FFProbe 
Extract text from older binary (.doc) Word files antiword
Read contents of Mircosoft Outlook PST files readpst
Examine embedded header information in images pyExifToolGUI
Generate images of problematic disks or particular disk types 
(I addition to Guymager

dd, dcfldd, ddrescue, cdrdao (for 
audio CDs)

Extract and analyze data from Windows Registry files regripper
Identify files that are partially similar but not identical sdhash, ssdeep
Package files for storage and/or transfer BagIt (Java) library, Bagger 
File preview (left-click on file then hit space bar) gnome-sushi



160

Other functionality to meet user needs
Function Tool(s)
Play and examine metadata from AV media files VLC media player
Damaged/lost partition recovery TestDisk
Damaged/lost file recovery PhotoRec
Identify the filesystem on a disk disktype
Index and search for keywords in documents recoll
Find blacklist data by using hashes calculated from hash 
blocks

hashdb

Generate hashes of files and blocks GTK Hash, md5deep, md5sum
Compare hashes of files to hashes in the National Software 
Reference Library (NSRL) of known system files

nsrllookup

View and edit bytestreams (hex editor) Bless Hex Editor, GHex



■ Opens up many more possibilities, such
as:
◻ stringing tools together
◻ performing batch operations
◻ changing parameters from their default values
◻ using tools that are only available through the

command line (no GUI)
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Command Line Operations



■ Role of pipes – feed output from one process into  
another process

■ Switches – settings that can be applied to a  
command (e.g. -a, -r)

■ Argument – a specific piece of data that 
is processed by a program (e.g. a variable or 
fixed value)

■ Regular expressions – used to find patterns (more  
on this later)

■ Text created in Windows and Unix, even 
though they’re both ASCII, will encode new lines 
differently, so you may need to translate using a 
tool such as dos2unix or unix2dos.
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Some Considerations



■ mkdir – make a directory
■ cd – change the directory that you’re in [“cd ..” goes to 

the  parent of the current directory]
■ ls – list contents of a directory
■ md5sum – generate cryptographic hashes
■ cat – output content of a text file (can be concatenation 

of  contents of two files)
■ file – determine file types based on magic numbers
■ strings – matches patterns in the text (ASCII) parts of a file 

(file  can be binary)
■ diff – compare two files
■ hexdump – very basic (non-GUI) hex viewer
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Some Important Commands and Tasks



■ man – manual page that explains how to run 
a command or some other technical information  (e.g. 
ascii page)

■ control-z – quit currently running program
■ clear – clear the screen (hide text from previous

commands)
■ Up arrow – cycles through previous commands, so you 

can rerun (or adapt) them
■ Tab – hit this key after you’ve started typing a string that 

the operating system can fill in for you (e.g. a long file 
name). Hitting tab multiple times will cycle through 
available options.
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General Unix/Linux CLI Tips
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Exercise: Basic Linux Commands
■ The saa-dfa-sample-data.zip file you downloaded earlier 

contains a folder of sample files named file_ident_ex 
■ If you haven’t done this already, add shared folder to BitCurator VM,

pointing to the desktop of the host

■ Move the file_ident_ex folder to the BitCurator VM desktop
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Exercise: Basic Linux Commands
Open a terminal in the BitCurator environment (using the 
Terminal icon in the dock)
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Exercise: Basic Linux Commands

sudo apt-get install most

Command Reason/Explanation

pwd Show the directory you’re currently in

ls List the contents of the current directory

cd Desktop Change the current directory to Desktop

ls List the contents of the current directory

unzip files.zip Decompress and unpack content of files.zip

ls List the contents of the current directory

cd files Change the current directory to files

ls List the contents of the current directory

md5sum [file name of first file] > firsthash Create a hash of a file and output it to a text file

less firsthash Display the content of the output to the screen

Control-z Stop the “less” program

md5sum [file name of second file] > secondhash Create a hash of a second file and output it to a text file

cat firsthash secondhash > bothhashes Combine the context of the two output files

more bothhashes Display the content of the output to the screen

most bothhashes Display the content of the output to the screen (follow  
instructions for adding it), then run this command again

Gives you the right  
administrative  
permissions

Uses Advanced Packaging  
Tool to get the program
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Exercise: Basic Linux Commands

Command Reason/Explanation

rm firsthash Delete (remove) firsthash file

rm secondhash Delete (remove) secondhash

ls List the contents of the current directory

hexdump [file name] -C | less Show hex dump of a given file [-C switch shows the  
standard view of hex on left and ASCII on right]

Use up and down arrows Navigate within the hex view of the file’s content

:q Quit the “less” program



169

Exercise: Siegfried and Brunnhilde
■ Over the next few slides, we will run Siegfried and 

Brunnhilde in over the same set of files in  several 
different ways

■ Goals
◻ Generate characterization and related technical 

metadata
◻ Illustrate how the data can be configured for different 

uses
◻ Identify decision points when data are unclear

■ Source files to analyze: file_ident_ex directory in 
the the zip file you downloaded and extracted 
earlier
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Installing Siegfried and Brunnhilde

■ Start up the BitCurator VM (if it’s not already running)
■ Open a Terminal Window
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Installing Siegfried and Brunnhilde
■ Enter the following commands in Terminal:

◻ wget -qO -  
https://bintray.com/user/downloadSubjectPublicKey?username=bintr  
ay | sudo apt-key add –

◻ echo "deb http://dl.bintray.com/siegfried/debian wheezy main" | sudo
tee -a /etc/apt/sources.list

◻ sudo apt-get update && sudo apt-get install Siegfried
◻ sudo pip install brunnhilde

■ Note: there is a text file in the sample files that includes these
commands if you want to copy/paste them

http://dl.bintray.com/siegfried/debian
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Running Siegfried and Brunnhilde I

■ Ensure you have 
extracted the 
saa-dfa-sample-data.zip 
file

■ Create a shared folder 
(we’ll step you through 
this)

■ Start up the BitCurator VM
■ Create “sieg-out” and  

“brunn-out” folders on the  
desktop

■ Drag “file_ident_ex” folder  
from the shared 
saa-dfa-sample-data 
directory to the Desktop
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Running Siegfried and Brunnhilde II

■ Open a Terminal window
■ At the prompt, enter the following command:

◻ sf ~/Desktop/file_ident_ex/ > ~/Desktop/sieg_out/sieg_out.yaml

■ Open the sieg_out directory and look around
◻ What did the command do?
◻ What does the file tell you?
◻ How would you characterize the data presented in 

the file?
◻ Does anything strike you as odd? Particularly 

useful?
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Running Siegfried and Brunnhilde III

■ In the same Terminal window, enter the following commands:
◻ sf -droid ~/Desktop/file_ident_ex/ > ~/Desktop/sieg_out/sieg_out-droid.csv
◻ sf -json ~/Desktop/file_ident_ex/ > ~/Desktop/sieg_out/sieg_out-json.json

■ Open the sieg_out directory and look around
◻ What did the commands do?
◻ How do these files differ from the one created on the previous slide?
◻ Between the three output files, which do you think is most useful 

presentation  of the data? (Hint: there may be more than one answer)
◻ Do any of these files strike you as particularly useful? Particularly 

worthless?
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Running Siegfried and Brunnhilde IV
■ In the same Terminal window, enter the following command:

◻ brunnhilde.py -w ~/Desktop/file_ident_ex/ ~/Desktop/brunn_out/DAS-FileIdent

■ Open the brunn_out directory and look around
◻ Did Brunnhilde perform any tasks over and above Siegfried?
◻ How do the Brunnhilde output files differ from those generated by Siegfried?
◻ Inspect csv_reports. How would you characterize what you see here?
◻ Are the files here that Brunnhilde and Siegfried found problematic? 

What  conclusions might you draw from them?
◻ Is there information that Brunnhilde highlighted that you missed in Siegfried’s

output?



■ What is a regular expression, or regex?
◻ Simply a pattern for matching bits of text.

■ What are regex’s useful for?
◻ Three things:

1. Matching: Does this text contain a pattern?
2. Replacement: Replace some part of the text with
other text

3. Extraction: Yanking out a bit of the text to use
somewhere else.
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Regular Expressions



■ Regular expressions may contain ordinary  
letters, numbers, and a few special symbols 
that allow you to match a wide range of 
patterns with a small amount of syntax.

■ A regex needs to be interpreted by a program  
(such as a Perl or Python script) or by an  
application (such as the Forensic Toolkit)

■ Regular expression syntax may look different
in different languages and programs.
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Regular Expressions



Character Meaning

. Match anything

+ Match one or more occurrences

* Match zero or more occurrences

^ Match only at the start of the text

$ Match only at the end of text

\w Match an alphanumeric word

\d Match a number

\s Match any whitespace

\S Match anything except whitespace
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Regular Expressions – Special Characters
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Regular Expressions - Examples

Expression Explanation

r+ Match the letter 'r' one or more 
times

t* Match the letter 't' zero or more 
times

\d Match any single digit 
(shorthand for the expression 
[0-9]

\dd Match any pair of digits 
(alternatively, [0-9][0-9])



What's "wrong" with the second and third regex 
patterns shown here? What else might they match?
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Regular Expressions – More Complex 
Examples

Expression Explanation

\d+\.\d+ Any two-digit decimal number 
(e.g. 5.0, 15.2345)

\d+(\.\d+)* Any integer or decimal number 
(e.g. 5, 5.0, 15.2345)

(\d\d\d\d)-(\d\d)-(\d\d) Match any date strings of the 
form YYYY-MM-DD



■ Tools for building regular expressions one
part at a time

■ Various default regular expressions that
you can use or adapt
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Regular Expressions in FTK



Try it at https://alf.nu/RegexGolf
182

For Fun on Your Own – Regex Golf!

https://alf.nu/RegexGolf


Extracting Data From
Specific Types of Files

183



■ Possible tags:
https://exiftool.org/TagNames/EXIF.html 
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Exchangeable Image File Format (EXIF)

https://exiftool.org/TagNames/EXIF.html


Example of EXIF Metadata from a JPEG File (Generated Using exiftool*)

: 9.38
---- ExifTool ----
ExifTool Version Number
---- System ----

: IMG_20130823_151811.jpgFile Name  
Directory  
File Size

: C:/Users/callee/Documents/images/digital-forensics-lab
: 1785 kB

File Modification Date/Time  
File Access Date/Time
File Creation Date/Time

: 2013:08:23 16:36:44-04:00
: 2013:10:14 17:13:02-04:00
: 2013:08:23 16:36:44-04:00

: rw-rw-rw-

: JPEG
: image/jpeg
: Big-endian (Motorola, MM)
: 2592
: 1944

: Baseline DCT, Huffman coding
: 8

: 3
: YCbCr4:2:0 (2 2)

File Permissions
---- File ----
File Type  
MIME Type  
Exif Byte Order  
Image Width  
Image Height
Encoding Process  
Bits Per Sample  
Color Components
Y Cb Cr Sub Sampling
---- GPS ----
GPS Img Direction  
GPS Img Direction Ref  
GPS Latitude Ref  
GPS Latitude
GPS Longitude Ref  
GPS Longitude  
GPS Altitude Ref  
GPS Altitude
GPS Time Stamp

: 83
: Magnetic North

: North
: 35 deg 55' 2.24"

: West
: 79 deg 2' 57.55"
: Above Sea Level

: 0 m
: 19:18:06

: NETWORK
: 2013:08:23

GPS Processing Method  
GPS Date Stamp
---- IFD0 ----

: Unknown (0)
: Galaxy Nexus

: 2013:08:23 15:18:11
: Centered

: 72
: inches
: 72

: Samsung

Orientation
Camera Model Name  
Modify Date
Y Cb Cr Positioning  
Y Resolution  
Resolution Unit
X Resolution  
Make
---- ExifIFD ----
Create Date  
Date/Time Original  
Exif Version
Flash Energy  
Image Unique ID  
Exposure Time  
ISO

: 2013:08:23 15:18:11
: 2013:08:23 15:18:11

: 0220
: 0

: OAEL01
: 1/17

: 125, 0, 0

Scene Type  
Exposure Index

: Directly photographed
: undef

Components Configuration : Y, Cb, Cr, -
F Number : 2.8
Compressed Bits Per Pixel : 0  
Sensing Method
Exposure Program

: One-chip color area
: Aperture-priority AE

: 2.6
: 0

: Unknown
: 1/15

: 0 m
: Normal

Aperture Value  
Brightness Value  
Subject Distance Range  
Shutter Speed Value  
Subject Distance  
Saturation
Color Space : sRGB

: Normal
: Multi-spot

Contrast  
Metering Mode  
Flashpix Version :

: 0
: 1944

: 2.6

Exposure Compensation  
Exif Image Height
Max Aperture Value
Sharpness
Exif Image Width  
Focal Length  
Digital Zoom Ratio  
Light Source
Scene Capture Type

: Normal
: 2592

: 3.4 mm
: 1

: Fluorescent
: Standard

: Off, Did not fire
: Custom

: Auto
: Auto

: JPEG (old-style)
: 160
: 120
: 1239
: 7164

Flash
Custom Rendered  
White Balance  
Exposure Mode
---- IFD1 ----
Compression  
Image Width  
Image Height  
Thumbnail Offset  
Thumbnail Length
---- Composite ----  
Aperture
GPS Altitude  
GPS Date/Time  
GPS Latitude  
GPS Longitude  
GPS Position  
Image Size  
Shutter Speed  
Thumbnail Image  
Focal Length  
Light Value

: 2.8
: 0 m Above Sea Level

: 2013:08:23 19:18:06Z
: 35 deg 55' 2.24" N
: 79 deg 2' 57.55" W

: 35 deg 55' 2.24" N, 79 deg 2' 57.55" W
: 2592x1944

: 1/17
: (Binary data 7164 bytes, use -b option to extract)

: 3.4 mm
: 6.7

*https://exiftool.org/TagNames/EXIF.html (Also available through the BitCurator environment) 185

https://exiftool.org/TagNames/EXIF.html


• Start up the BitCurator VM
• Download one or more pictures to your desktop that you’d like to examine
• Options for viewing EXIF:

1. PyEXIFToolGUI:
• Navigate to Desktop > Forensics Tools > PyEXIFToolGUI
• Open the tool and select File > Load Images
• Let’s also add some GPS coordinates: Select Edit Data, enter the  

values, then select Save to Selected Image(s) [Make sure that the  
image is selected]

2. File info menu:
• Navigate to the image file
• Right click on it and select Scripts > File Info > Meta Information [Pick  

EXIF Data]
3. exiftool at the command line:

• Open a command prompt window
• Navigate to where you stored the image (e.g. cd Desktop)
• Type: exiftool [Filename]
• Note: You can scroll up and down by using Shift + Page Up/Page  

Down, or you can invoke the command as exiftool [Filename] | less  
(type “q” to quit)
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Exiftool Exercise in BitCurator



• Download one or more pictures to your desktop that you’d like to examine
• Download and unzip the latest Windows executable (or Mac package) from:

https://exiftool.org/ 

• Save exiftool(-k).exe to your desktop
• Change file name to: exiftool(-k -a -u -g1 -w txt).exe [NOTE: This is changing the  

parameters for running the software – same as if you were to add these  switches at the 
command line. This trick might not work on a Mac, but you can always issue the commands 
directly.]

• -k = pause the program before terminating
• -a = allow extraction of duplicate tags
• -u = extract unknown tags
• -g1 = organize output by tag group
• -w = write output text file

• Drag and drop pictures onto the exiftool icon and examine the results
• Change file name to: exiftool(-X -k -a -u -g1 -w xml).exe
• Drag and drop pictures onto the exiftool icon and examine the results
• For more about exiftool, see: https://github.com/exiftool/exiftool 
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Optional Exiftool Exercise (Windows or Mac)

https://exiftool.org/
https://github.com/exiftool/exiftool
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Stripping 
Metadata 
From 
Images

https://www.embeddedmetadata.org/social-media-test-results.php 

https://www.embeddedmetadata.org/social-media-test-results.php


■ Are the “new” office formats (ODF and
OOXML) better or worse for forensics?

■ What kinds of information can you get out
of them?

■ What sorts of approaches might you take  
to view and/or extract the information?
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Office Documents



■ Your zip file contains a document named “The NDSA Levels of 
Digital Preservation.pptx”
(also at 
http://library.harvard.edu/sites/default/files/The%20NDSA%20Levels%20of%20Digital%20Prese
rvation_3.pptx)

■ Change the file extension to .zip
■ Open it with 7-Zip or WinZip
■ Extract all the files
■ Examine the contents of the resulting

directory
◻ Can you find a thumbnail of the first slide?
◻ Where are the slides stored?
◻ Where are embedded images stored?
◻ Can you determine who created the file?
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Office Documents – PPTX File Example

http://library.harvard.edu/sites/default/files/The%20NDSA%20Levels%20of%20Digital%20Preservation_3.pptx
http://library.harvard.edu/sites/default/files/The%20NDSA%20Levels%20of%20Digital%20Preservation_3.pptx
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Jonathan Larson Fast Save Example

https://www.nypl.org/blog/2011/04/22/no-day-today-look-jonathan-larsons-word-files 

https://www.nypl.org/blog/2011/04/22/no-day-today-look-jonathan-larsons-word-files
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Hidden Data Exercise – Using a Hex Editor

■ Open the file 
in HxD (or upload 
to https://hexed.it)

■ Go to offset 73B90 
(use Search > Goto 
or just Control+G)

■ What do you 
see there?

■ What does it tell 
you about 
the document?

Your zip file contains a document named ar99.doc (also at:
http://web.archive.org/web/20000816164723/http://microsoft.com/msft/ar99/downloads/ar99.doc)

https://hexed.it
http://web.archive.org/web/20000816164723/http:/microsoft.com/msft/ar99/downloads/ar99.doc
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Hidden Data Exercise – Inspection in MS 
Word

■ Do the following:

◻ Open it in Word – what is
it?

◻ If prompted to do so at 
the  top, select “Enable 
Editing”

◻ Select: File > Options >  
Trust Center > Trust 
Center  Settings…

◻ Then Privacy Options >
Document Inspector >

Inspect
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Hidden Data Exercise – Inspection in MS 
Word

■ Are you prompted
with this?

■ Why do you think
this is?

■ If you see this,  
click OK, then  
save the  
document

■ Run Document
Inspector again

■ What does it tell
you?



■ What’s in an email header?
■ Which parts of the header would be of  

most interest to you as someone  
responsible for managing and preserving a  
collection that includes email?

■ Which parts of the header would be of
most interest to future researchers?
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Email
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Windows Artifacts



197

Desktop Operating System Market Share

https://gs.statcounter.com/os-market-share/desktop/worldwide

https://gs.statcounter.com/os-market-share/desktop/worldwide


Let’s make sure you can see all the files on your
computer.

198



199



200



201



202



■ Information about:
◻ Applications installed
◻ Application settings
◻ Hardware installed
◻ Hardware settings
◻ User interface and system preferences
◻ User accounts
◻ Locations of files and recent activities, e.g. 

Most Recently Used (MRU)
◻ Lots of online activities, e.g. usernames and

passwords, browsing and search query history
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Windows Registry



File Description
NTUSER.DAT One for each user account, includes information  

such as Most Recently Used (MRU) file lists,  
desktop settings, default application behaviors

SAM (Security Accounts
Manager)

User account information (including passwords)
and security settings

SECURITY User and group security policies, e.g. which  
accounts can load device drivers, get remote  
access to the machine

SOFTWARE Information about all install programs, including
settings and directory paths

SYSTEM Windows systems settings, such as drive letter  
mappings, storage volume information, system  
boot profile, last known good configuration,  
system name, Windows setup information,  
hardware profile information
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Five Main Registry Files



Where are They Located?
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Structure:

Hive
• Key

• Subkey
• Value

Example:  
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\  
RecentDocs

What do you think this is?
206

Registry Hives



Name Description

HKEY_CLASSES_ROOT Just points to  
HKEY_LOCAL_MACHINE\Software\Classes

HKEY_CURRENT_USER User setting information, which is generated  
dynamically from HKEY_USERS when a user  
logs into Windows

HKEY_LOCAL_MACHINE Hardware and software settings that are specific  to 
this computer but shared across users  (generated 
at startup from SYSTEM.DAT)

HKEY_USERS Information about each of the user accounts on  the 
computer, e.g. desktop settings, default  software 
behaviors - generated at startup from  
NTUSER.DAT files, and when user logs out of  
applications or out of Windows, data are written  
back to the ntUSER.DAT files

HKEY_CURRENT_CONFIG Just points to HKEY_LOCAL_MACHINE\Config

Question: Where would you find these registry hives on a disk image? (Hint:  
This is a trick question) 207

Registry Hives
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Registry Hive Value Types
Type Description

REG_BINARY Raw binary data displayed as hexadecimal*

REG_DWORD 32-bit unsigned integer (4 bytes)

REG_EXPAND_SZ Variable-length string, usually in UTF-16 (Unicode)

REG_FULL_RESOURCE_DESCRI
PTOR

Series of nested arrays used by a hardware device,
binary data displayed as hexadecimal*

REG_LINK Symbolic link to another registry key (Unicode)

REG_MULTI_SZ Ordered list of strings (multi-string value), usually in UTF-  
16

REG_NONE No specific type – displayed as hexadecimal*

REG_QWORD 64-bit integer (8 bytes)

REG_RESOURCE_LIST Series of nested arrays used by a hardware device,
binary data displayed as hexadecimal*

REG_RESOURCE_REQUIREMEN  
TS_LIST

Series of nested arrays used by a hardware device,  
binary data displayed as hexadecimal*

REG_SZ Fixed-length text string, usually in UTF-16

* Can be opened and viewed in a hex editor



■ One assigned to each user account
■ Associated with various resources,

including files, folders and Recycling Bins
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Security ID (SID)



S-1-5-21-1180590209-877416012-3186324384-1002

211

SID Example



S-1-5-21-1180590209-877416012-3186324384-1002

Always an “S”, indicating that this
is an SID.
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S-1-5-21-1180590209-877416012-3186324384-1002

Revision level (version of the SID
specification being used).
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S-1-5-21-1180590209-877416012-3186324384-1002

Authority that issued the SID.  
Value is usually “5”, indicating NT  
Authority.
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S-1-5-21-1180590209-877416012-3186324384-1002

Domain identifier – value can be
up to 500.
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S-1-5-21-1180590209-877416012-3186324384-1002

Account or group on a domain or
local machine
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S-1-5-21-1180590209-877416012-3186324384-1002

Relative Identifier (RID), designating a  
specific user in the SAM file. Those  
below 1000 are default accounts (e.g.  
500 = Administrator), and those 1000 or  
above are created for specific groups or  
users.
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■ The files in registry (a folder within the zip file 
you downloaded earlier) were extracted from 
a full-drive (including the operating 
system) disk image

■ The following is an example of how these files 
can be extracted using FTK Imager
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Examining an NTUSER.DAT File
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■ Navigate to: Partition 1 > [root] > Documents and Settings > Charlie >
NTUSER.DAT

■ Right click on NTUSER.DAT and select Export Files.
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Then export the other four registry files from Windows\System32\config
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Perform these same tasks in the BitCurator 
environment
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RegRipper Instructions - BitCurator

■ Navigate to Forensics Tools, and click on the 
RegRipper icon

■ NOTE: IGNORE examples that it presents, 
because they use commands and syntax for 
Windows, not Linux

■ Issue each of the following commands:

perl rip.pl -r ~/Desktop/sample-data/registry/NTUSER.DAT > ~/Desktop/ntuser-report -f ntuser

perl rip.pl -r ~/Desktop/sample-data/registry/SAM > ~/Desktop/sam-report -f sam

perl rip.pl -r ~/Desktop/sample-data/registry/SECURITY > ~/Desktop/security-report -f security

perl rip.pl -r ~/Desktop/sample-data/registry/SOFTWARE > ~/Desktop/software-report -f software

perl rip.pl -r ~/Desktop/sample-data/registry/SYSTEM > ~/Desktop/system-report -f system

*Enter each command in its entirety before hitting enter (line breaks above are simply to fit the text 
onto the slide, not ones that  you should type yourself). Remember that the up arrow and tab can save 
you time when typing commands.
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RegRipper Instructions – Windows I

• Create a folder called regripper-exercise on your desktop
• Find the registry directory in the folder you extracted from the 

saa-das-sample-data zip file earlier
• Copy this folder to the regripper-exercise folder on your Desktop
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RegRipper Instructions – Windows II

• Navigate to saa-dfa-sample-data\RegRipper3.0
• Run rr.exe (it may simply appear as rr) by double clicking it.
• The next set of steps will be run 5 times - once for each of the files in 

regripper-exercise\registry
• Next to the Hive File window, select Browse

• Navigate to regripper-exercise\registry  and select the first Hive File
• E.g., NTUSER.DAT

• Next to Report File, select Browse
• Create a new file in regripper-exercise  that corresponds to the Hive 

File above
• E.g., NTUSER_report.txt

• In the Profile dropdown, select the appropriate
profile

• E.g., ntuser profile selection is not required in RegRipper 3.0
• Select Rip It.
• Repeat the above steps for SAM, SECURITY,

SOFTWARE, and SYSTEM
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RegRipper Output Questions
Examine ntuser-
report.txt

Are you able to identify files that the user recently
opened? If so, what were they? Can you determine what
the most recently opened files of specific types (e.g. txt)
were?

Examine sam-report.txt How many accounts were there on the computer that is
represented in the disk image? What is the Relative
Identifier (RID) for the user account you’re examining?  What 
other interesting information can you gain from the  SAM report 
about this user account and how might you  use that 
information?

Examine security-
report.txt

What is the Machine SID for the computer represented in
the disk image? Why would you want to know this? How  does it 
relate to the RID that you identified above?

Examine software-
report.txt

Identify three different applications that were installed on
the computer and the file paths where the applications  were 
stored.

Examine system-
report.txt

Find the devclass output. What does this output tell you?
How might this information be useful?
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RegRipper Output Discussion – ntuser-report
• Are you able to identify the files that the user recently opened? If 

so,  what were they?
• How did you go about finding this information?
• What line number(s) points to this information?

• Can you determine what the most recently open files of specific types
(e.g. txt) were?

• How did you go about finding these?
• What line numbers have this information?

• Look at lines 1109-1117 - what type of information are you looking at?

• Is there any other information you find particularly compelling in this  
report?

• What might you do with this information?
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RegRipper Output Discussion – sam-report

• How many accounts were there on the this computer?
• How did you go about finding this information?
• What line number(s) points to this information?

• What was the Relative Identifier (RID) for the user account you’re  
examining?

• How did you go about finding this?

• How many logins did Pat make on this machine?

• Is there any other information you find particularly compelling in this
report?

• What might you do with this information?



• What is the Machine SID for the computer represented here?
• How did you go about finding this information?
• What line number(s) points to this information?

• Why would you want to know this information

• How does this relate to the RID in the previous report?

228

RegRipper Output Discussion – security-report
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RegRipper Output Discussion – software-report
• Identify three different applications that were installed on this computer

• How did you go about finding this information?
• What line number(s) points to this information?

• Why would you want to know this information?

• How might it aid description?
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RegRipper Output Discussion – system-report

• Find the devclass output
• What does this output tell you?
• How might this information be useful?



■ What if you’re logged in to the 
original computer? How might you get 
information out of the registry?

■ What if you wanted to replicate that
registry information on another computer?

■ Hint: There are tools built into Windows for
this.
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Viewing and Copying Registry Information if 
You're Running the Original Environment
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Restore Points

■ Snapshots of Registry hives and some other  
essential system (including .EXE, .INI, .LNK) files. 
They’re created:
◻ when there are major system changes, e.g.

installing software
◻ at regularly scheduled intervals
◻ if the user manually creates one

■ Let’s look at some restore points: Start 
Button > All Programs > Accessories >  
System Tools > System Restore [or just 
"System Restore" in the Start box]



1. In the start menu box, type cmd
2. Type: cd c:\$recycle.bin 

(What is this doing?)
3. Type dir /a 

(What is this doing?)
4. Type dir *.* /s 

(What is this doing?)
5. Put one or more files into the Recycle Bin

(by moving there or by deleting)
6. Repeats steps 2-4. What do you see now?
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Examining the Recycle Bin



■ No Registry, so where is all the good stuff
stored?

■ See: 
https://forensicswiki.xyz/wiki/index.php?title=Ma
c_OS_X_10.9_-_Artifacts_Location but note 
that this is information a snapshot in time; 
artifact locations tend to change between 
versions of macOS.
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A Brief Discussion of Mac Forensics

https://forensicswiki.xyz/wiki/index.php?title=Mac_OS_X_10.9_-_Artifacts_Location
https://forensicswiki.xyz/wiki/index.php?title=Mac_OS_X_10.9_-_Artifacts_Location


■ If the volume is NTFS, you can find the  
SID associated with a specific file

■ If you also have registry files from the  
original computer (particularly SAM.DAT),  
you can get information associated with  
that SID, such as the name of the  
user/group, last time he/she logged in, and  
various other account details
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Archival Importance and Role of SID



setuplog.txt
• See disk image example below: Partition 1 > [root] > WINDOWS > setuplog.txt

• What do you see in this file?
• What information could be useful for digital curation?
• When/how might you use it?
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■ Virtualization and emulation
■ Mounting the original filesystem
■ Accessing (but not mounting) disk images

using forensics software
■ Remote, dynamic access to disk image  

contents
■ Cross-drive analysis

*Note: The first three were discussed earlier
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End User Access Scenarios*



■ Two-year project (October 1, 2014 – September 30, 
2016) at School of Information and Library Science, 
University of North Carolina at Chapel Hill

■ Funded by Andrew W. Mellon Foundation
■ Developing open-source software to support access to 

disk images. Core areas of focus: 
◻ Tools and reusable libraries to support web access 

services for disk images
◻ Analyzing contents of file systems and associated 

metadata
◻ Redacting complex born-digital objects (disk images)
◻ Emulated access to data from disk images
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BitCurator Access Redaction Tools

■ Software to redact strings and byte sequences identified in 
disk images

■ Three types of redaction actions: 
◻ SCRUB (overwrite the bytes in the target with zeroes),
◻ FILL (overwrite by filling with a given character),
◻ FUZZ (altering the content of a binary, so it can no longer run). 

■ Best used through a command-line interface but also include 
a graphic user interface (GUI) that supports the same 
functions

■ Python API allowing institutions to develop custom redaction 
facilities using open-source tools including lightgrep

https://github.com/bitcurator/bitcurator-access-redaction

https://github.com/bitcurator/bitcurator-access-redaction


• Funded by Andrew W. Mellon Foundation: October 1, 2016 
– September 30, 2018

• Develop software for collecting institutions to extract, 
analyze, and produce reports on features of interest in text 
extracted from born-digital materials 

• Use existing natural language processing software libraries 
to identify and report on those items likely to be relevant to 
ongoing preservation, information organization, and access 
activities

• May include entities (e.g. persons, places, and 
organizations), potential relationships among entities (e.g. 
appear together within documents or set of documents), 
and topic models to provide insight into how concepts are 
naturally clustered within the documents.
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This is 
showing 
topic 
modeling, 
which we’ll 
look at in 
more detail 
soon.
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Another path 
at this point 
is to feed the 
text into 
spacy for 
named-entity 
recognition
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BitCurator Access Webtools
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BitCurator Access Webtools
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BitCurator Access Webtools
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Topic Modeling in bitcurator-nlp-gentm (using 
pyLDAvis



Source: Simson L. Garfinkel, “Forensic Feature Extraction and Cross-Drive Analysis,”
Digital Forensics Research Workshop, August 15, 2006.
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Incorporating digital forensics
into archival workflows

252



Storage Media Acquisition and Handling Profile for Digital Repositories*

*Woods, Kam, Christopher A. Lee, and Simson Garfinkel. “Extending Digital Repository Architectures to Support Disk Image  
Preservation and Access.” In JCDL '11: Proceeding of the 11th Annual International ACM/IEEE Joint Conference on Digital 
Libraries,  57-66. New York, NY: ACM Press, 2011. 253



BitCurator-Supported Workflow

See: https://bitcurator.net/ 

• Acquisition
• Reporting
• Redaction
• Metadata Export
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Five Sources of Workflow Examples
Martin J. Gengenbach, “’The Way We Do it Here’: Mapping Digital 
Forensics Workflows in Collecting Institutions,” A Master’s Paper for the 
M.S. in L.S degree. August 2012.
https://web.archive.org/web/20170526011942/http://digitalcurationexcha
nge.org/system/files/gengenbach-forensic-workflows-2012.pdf 

AIMS Work Group, “AIMS Born-Digital Collections: An Inter-Institutional 
Model for Stewardship,” January 2012. 
https://dcs.library.virginia.edu/files/2013/02/AIMS_final.pdf 

Digital Sustainability Lab – Massachusetts Institute of Technology
https://web.archive.org/web/20160408225012/http://www.dpworkshop.or
g/sites/default/files/DCM-Pipeline_28Apr2015.pdf 

Workflows, BitCurator Consortium 
https://bitcuratorconsortium.org/workflows

OSSArcFlow Project - https://educopia.org/research/ossarcflow

https://web.archive.org/web/20170526011942/http:/digitalcurationexchange.org/system/files/gengenbach-forensic-workflows-2012.pdf
https://web.archive.org/web/20170526011942/http:/digitalcurationexchange.org/system/files/gengenbach-forensic-workflows-2012.pdf
https://dcs.library.virginia.edu/files/2013/02/AIMS_final.pdf
https://web.archive.org/web/20160408225012/http:/www.dpworkshop.org/sites/default/files/DCM-Pipeline_28Apr2015.pdf
https://web.archive.org/web/20160408225012/http:/www.dpworkshop.org/sites/default/files/DCM-Pipeline_28Apr2015.pdf
https://bitcuratorconsortium.org/workflows
https://educopia.org/research/ossarcflow


Martin J. Gengenbach, “’The Way We Do it Here’: Mapping Digital Forensics Workflows in Collecting Institutions,” A Master’s 
Paper for the M.S. in L.S degree. August, 2012. 256



AIMS Work Group, “AIMS Born-Digital Collections: An Inter-Institutional Model for Stewardship,” January 2012. 257



Kari Smith, Massachusetts Institute of Technology. 
https://web.archive.org/web/20160408225012/http://www.dpworkshop.org/sites/default/files/DCM-Pipeline_28Apr2
015.pdf 
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https://bitcuratorconsortium.org/workflows
259

https://bitcuratorconsortium.org/workflows


https://educopia.org/research/ossarcflow
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■ Incorporation into LAM workflows, 
e.g. metadata conventions, connections 
to collection management systems

■ Obsolete storage media and filesystems
■ Dealing with large, internally complex 

data files
■ Provision of public access
■ Defining and implementing ethical 

commitments
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Challenges



“A community-based approach would use SWAT sites wherein a few self  
selected institutions acquire and maintain the gear and expertise to read  
data and transfer content from particular types of obsolete media. The  
SWAT sites would provide transfer services for institutions that don’t have  
the capacity to read a particular medium (or the SWAT sites might  
become the likely places to deposit particular types of media).”

Erway, Ricky. “Swatting the Long Tail of Digital Media: A Call for Collaboration.” 
Dublin, Ohio:  OCLC Research, 2012. 
http://www.oclc.org/research/publications/library/2012/2012-08.pdf

See also:
Ricky Erway and Ben Goldman, “Agreement Elements for Outsourcing Transfer of  
Born Digital Content,” August 2014,  
http://oclc.org/research/publications/library/2012/2012-06r.html#agreement

262

SWAT (Software and Workstations for 
Antiquated Technology) Sites

http://www.oclc.org/research/publications/library/2012/2012-08.pdf
http://oclc.org/research/publications/library/2012/2012-06r.html#agreement


Legal and Ethical Issues
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■ What ethical dilemmas related to born-  
digital materials have you faced or do you  
expect to face?

■ What would the competing interests or
values be?

■ How would you decide?
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Ethical Dilemmas



■ Donor agreements (as of 2012) tend not to  
address the kinds of issues raised in this class*

■ What are the most important issues to resolve with  
creators/donors?

■ What’s the right level of detail to include in donor  
agreements and discussions with potential  
donors?

*Matthew J. Farrell, “Born-Digital Objects in the Deeds of Gift of Collecting Repositories: A Latent 
Content Analysis,” A Master’s Paper for the M.S. in L.S degree. July 2012,
https://cdr.lib.unc.edu/indexablecontent?id=uuid:385c4fd9-a403-4ba3-85ac-2ea128400ddb&ds=DATA_FILE
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Donor Agreements

https://cdr.lib.unc.edu/indexablecontent?id=uuid:385c4fd9-a403-4ba3-85ac-2ea128400ddb&amp;ds=DATA_FILE


■ Redwine, Gabriela, Megan Barnard, Kate Donovan, Erika  
Farr, Michael Forstrom, Will Hansen, Jeremy Leighton John,  
Nancy Kuhl, Seth Shaw, and Susan Thomas. "Born Digital:  
Guidance for Donors, Dealers, and Archival Repositories."  
Washington, DC: Council on Library and Information  
Resources, 2013.

■ Nelson, Naomi L, et al. "Gift/Purchase Agreements." In  
Managing Born-Digital Special Collections and Archival  
Materials, 122-126. SPEC Kit 329. Washington, DC:  
Association of Research Libraries, 2012. [Includes donor  
agreements and policies from Duke University, Bentley  
Historical Library, and Beinecke Rare Book and Manuscript  
Library]

■ Pyatt, Timothy D. "Deed of Gift Addenda for Collections with  
Electronic Records." Pennsylvania State University. 2012.
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Specific Guidance Documents



A Guide to Deeds of Gift – Society of
American Archivists*

Text added in 2013:

“Be aware that any digital materials that you donate, including  
computers, computer disks, and other digital storage media, may  
contain passwords, web browsing history, other users’ files, and  
copies of seemingly deleted files. Whether or not these files are  
apparent to researchers will depend on the initial method of  
transfer and on the repository’s access policies and procedures for  
handling digital material, which may change over time as  
technology evolves. Discuss any concerns about deleted content  
with the archivist or curator.”

*https://www2.archivists.org/publications/brochures/deeds-of-gift 
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What does it mean for 
electronically stored information 
(ESI) to be “accessible”?
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“The person responding need not provide  
discovery of electronically stored information  
from sources that the person identifies as 
not reasonably accessible because of 
undue burden or cost.” (Rule 45 (d)(1)(D))  
(emphasis added)
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Judge Shira Scheindlin:

"[t]he more information there is to  
discover, the more expensive it is to  
discover all the relevant information until, 
in the end, 'discovery is not just about 
uncovering the truth, but also about how 
much of the truth the parties can afford to 
disinter.' " 

(Zubulake I, 217 F.R.D. at 311 (quoting Rowe 
Entm’t,  Inc. v. William Morris Agency, Inc., 205  
F.R.D. 421, 423 (S.D.N.Y. 2002)).
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Seven-Factor Test from Zubulake v. UBS 
Warburg

1. extent to which the request is specifically tailored to
discover relevant information

2. availability of such information from other sources
3. total cost of production, compared to the amount in

controversy
4. total cost of production, compared to the resources

available to each party
5. relative ability of each party to control costs and its  

incentive to do so
6. importance of the issues at stake
7. relative benefits to the parties of obtaining the information

(217 F.R.D. at 322)



■ Active, online data
■ Near-line data
■ Offline storage
■ Backup tapes
■ Erased, fragmented or damaged data

*See: Lange, Michele C. S., and Kristin M. Nimsger. Electronic Evidence and  
Discovery: What Every Lawyer Should Know Now. 2nd ed. Chicago, IL: Section of  
Science & Technology Law American Bar Association, 2009. p.75.
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Zubulake's Five Categories of ESI (Most to 
Least Accessible)*



Magistrate Judge John Facciola:

"…I am anything but certain that I 
should permit a party who has failed to 
preserve accessible information without 
cause to then complain about the 
inaccessibility of the only electronically 
stored information that remains"
 
(Disability Rights Council of Greater  Wash. v. 
Wash. Metro. Transit Auth., 242  F.R.D. 139 
(D.D.C. 2007)).
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■ Most frequently discussed in library lit is copyright
■ Claims can extend far beyond intellectual property 

rights, as defined by law
■ Cultural property, replevin and repatriation
■ Right to privacy
■ Protection of human subjects in research
■ Privileged or protected information (e.g. 

client-attorney, healthcare, social services, library 
circulation, source – journalist)

■ Right to publicity – individual's protection from 
unauthorized commercial use of her name, persona, or 
likeness

■ Prevention of misappropriation (including plagiarism)
274

Rights to Control Information



"If a forensic examiner has complete  
confidence in his/her conclusions, this  
is usually an indication that he/she is  
missing something – there is always  
uncertainty and all assertions should be  
qualified accordingly...” 

Casey, Eoghan. "Error, Uncertainty, and Loss in Digital Evidence." International
Journal of Digital Evidence 1, no. 2 (2002).
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"Investigators cannot, in general, directly observe 
digital data and instead they can only observe the data 
displayed on a monitor or other output device, which is 
driven by various types of hardware and 
software. Because the observation of the data is 
indirect, a hypothesis must be formulated that the actual 
data is equal to the observed data. Testing this hypothesis 
requires that the hardware and software being used are 
accurate and reliable. Hypotheses also need to be 
formulated about the data  abstractions that exist and the 
previous states and events that occurred."*

*Carrier, Brian D. "A Hypothesis-Based Approach to Digital Forensic Investigations."  
Doctoral Dissertation, Purdue University, 2006. p.11 (emphasis added).
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■ Name embedded in a MS Word file is the document’s
author

■ Given IP address identifies an individual
■ Presence of email addresses on different hard drives

indicate correspondence patterns between individuals
■ Many common MD5 values across storage locations  

indicate sharing of files across those locations (context-  
based filtering can help to address this)

■ Last modified date indicates when a document was finalized
■ Parts of a page available through the WayBack Machine for  a 

given date represent the parts of the page as available on  that 
date
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Examples of Potentially Useful Inferences 
(that could be wrong)



"Even if a document can be traced to a particular 
computer and/or IP address, how can we identify 
who was actually at the keyboard composing the 
document? It is a particular problem in 
environments where multiple users may have 
access to the same computer or when users do 
not have to authenticate themselves to access 
a particular account."

Chaski, Carole. "The Keyboard Dilemma and Authorship Identification." In Advances  
in Digital Forensics III: IFIP International Conference on Digital Forensics, National  
Center for Forensic Science, Orlando, Florida, January 28-January 31, 2007, edited  
by Philip Craiger and Sujeet Shenoi. New York, NY: Springer, 2007. p.133.
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The "Keyboard Dilemma"



Shared Computer Use in the Home*

*Frohlich, David, and Robert Kraut. "The Social Context of Home Computing." In  
Inside the Smart Home, edited by Richard Harper, 127-62. London: Springer,  
2003.
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Ethics Questions To Consider
1. When acquiring a disk as part of a collection, should you create a bit-level  

image of the disk, in order to ensure the potential to recreate not only the  
“payload” data of files but also various forms of information within and below  the 
filesystem?

2. Should you retain “hidden” data in a Word document or only retain what you  
assume to be the text that the author intended?

3. You’re responsible for managing a Microsoft Outlook .pst file over time  (including 
saved and sent messages, calendar items, draft and deleted  messages, address 
book, and viruses). Should you retain the whole .pst file or  extract messages and 
attachments that were sent and received?

4. If a collection documents the life of an individual, how would you determine the  
appropriate scope for collecting information associated with that person’s  online 
presence (e.g. postings, affiliations, profiles, micro-contributions)?

5. If your institution routinely “normalizes” submitted files into designated file  
formats, are you obligated to ensure that the normalization doesn’t violate the  
intentions of creator or other interested stakeholders? If so, what does this  
obligate you to do specifically?

6. Someone cropped a set of images in order to remove sensitive parts, but the  
images still have pixel information and embedded thumbnail reflecting the  
“removed” parts. How should you approach the management of the images?

280



■ Digital forensics has arrived for archival
processing

■ Introduction of digital forensics doesn’t
dictate specific policies or practices

■ The disk image is the cornerstone of 
many forensics methods

■ “Taking bitstreams seriously” can have
major advantages

■ Disk images afford new access scenarios
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Lessons and Insights



Forensics Wiki. https://forensicswiki.xyz/page/Main_Page 

BitCurator Environment. https://bitcurator.net

BitCurator Software Overview. https://bitcurator.github.io/ 

Community Owned digital Preservation Tool Registry (COPTR) 
https://coptr.digipres.org/Main_Page

Information Guides on Tools for Electronic Records. Minnesota State Archives. 
https://www.mnhs.org/preserve/records/electronicrecords/erpreserveres.php

Lifecycle Tools for Archival Email Stewardship. 
https://docs.google.com/spreadsheets/d/1V1N22xnr5e0EbDlZWx58bjYO6rkrMr
YH9wGX9-CK8c4/

Tools for processing, managing, and preserving electronic records. University 
of Minnesota.
https://www.lib.umn.edu/dp/guides
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To Learn More About Available Software

https://forensicswiki.xyz/page/Main_Page
https://bitcurator.net/
https://bitcurator.github.io/
https://coptr.digipres.org/Main_Page
https://www.mnhs.org/preserve/records/electronicrecords/erpreserveres.php
https://docs.google.com/spreadsheets/d/1V1N22xnr5e0EbDlZWx58bjYO6rkrMrYH9wGX9-CK8c4/
https://docs.google.com/spreadsheets/d/1V1N22xnr5e0EbDlZWx58bjYO6rkrMrYH9wGX9-CK8c4/
https://www.lib.umn.edu/dp/guides


BitCurator User Group
https://groups.google.com/forum/#!forum/bitcurator-users
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Digital Curation List
https://groups.google.com/forum/#!forum/digital-curation

Online Forums

https://groups.google.com/forum/#!forum/bitcurator-users
https://groups.google.com/forum/#!forum/digital-curation
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Further Education



Thank you!

Go forth and curate the bits!
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This resource was released by the BitCuratorEdu 
project and is licensed under a Creative Commons 
Attribution 4.0 International License. 

Most resources from the BitCuratorEdu project 
are intentionally left with basic formatting and 
without project branding. We encourage 
educators, practitioners, and students to adapt 
these materials as much as needed and share 
them widely. 

The BitCuratorEdu project is a three-year effort 
funded by the Institute of Museum and Library 
Services (IMLS) to study and advance the adoption of 
digital forensics tools and methods in libraries and 
archives through professional education efforts. This 
project is a partnership between Educopia Institute 
and the School of Information and Library Science at 
the University of North Carolina at Chapel Hill, along 
with the Council of State Archivists (CoSA) and several 
Masters-level programs in library and information 
science.
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